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1. INTRODUCTION

The MR3000 is a new family of compact vibration and motion measurement system. As such it 
meets all user expectations in a state-of-the-art device and thus is a highly reliable and efficient 
instrument for various application fields.

The MR3000 is equipped with a newest generation of electronic components, which allows a strong 
reduction in power consumption while increasing the computing power. The MR3000 keeps the 
best features of the current family of recorders MR2002, with many new features, among them a 
reduced size and lighter weight. 

Given the widespread use of Internet, the user will be able to parametrize, download files and be 
informed  of  the  status  of  their  equipment  remotely  via  Internet.  In  addition,  because  a  fast 
communication interface a real-time data-stream from the recorders to a server is now possible. 

Also, the memory storage space has been strongly increased so that to keep the history of the 
equipment stored is now possible. The MR3000 allows the user to store a bigger amount of data, 
which is ordered in a logical way, and to have a powerful tool to sort/filter the data.

The MR3000 is a compact, triaxial accelerograph which can operate on a stand-alone basis and 
can be linked to a network. In general, the MR3000 systems can be pre-configured for the use with  
sensor  either  mounted  inside  or  connected  externally.  The  configuration  presented  in  this 
document corresponds to the former option.

The sensor picks up vibration and transforms it into an electrical signal which is proportional to 
acceleration. These signals are continuously digitized and stored in the memory. If the vibration 
exceeds the threshold level (trigger criteria are fulfilled), the contents of that memory is written to 
the internal  SD card.  The data  stored  in  the  SD card memory  may be retrieved via the LAN 
communication port. 

The MR3000 is also equipped with an external GPS antenna for a precise timing synchronization.

The MR3000 is water and shock resistant.  An external  rechargeable lead-acid battery ensures 
continuous operation  during power interruptions. 

The  MR3000,  called  sometimes  simply  MR,  is  very  easy  to  operate  and  requires  minimal 
maintenance. Routine maintenance and operation does not require any specialists. 

The internal/external sensor is described in a separate document, according to its type.
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1.1 Features

Major feature are:

• Compact unit with integrated sensor, digital recorder, wired and wireless connectivity

• ARM/DSP Technology with up to 32 GB Memory

• Integrated Web Server

• Precise timing (GPS, IEEE-1588 PTP or RFC-5905 NTP)

• Power over Ethernet (PoE, IEEE.802.3af)

• Wide dynamic range (132 dB)

• Sampling rates up to 1000 Hz

• Simple installation

• Easy operation

• High reliability

• Low maintenance.

1.2 Applications

• Civil Engineering

◦ Industrial Vibrations

◦ Construction Site Monitoring

◦ Tunneling

◦ Truck and Rail Traffic

◦ Blasting Monitoring

◦ Model Verification

• Earthquake Engineering

◦ Building Monitoring

◦ Monitoring of Structures (e.g., Dams, Bridges)

• Geology

◦ Soil Characterization

• Earth Science

◦ Earthquake Monitoring (Seismic Intensity)
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2. HARDWARE

2.1 Mechanical Drawing – Overview

Figure 1. Mechanical drawing of the MR – Top view.

Figure 2. Mechanical drawing of the MR – Side view.

1. Fixation of mounting plate
2. Bubble level 
3. Wi-Fi antenna 
4. Knurled screw  
5. Knurled screw  - below MR 
6. Mounting plate
7. Lid
8. GPS antenna.
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2.2 Connectors

The MR3000 provides three rugged connectors,  as it  is shown in Figure  3, namely,  Power for 
power  supply,  LAN for  communication/power,  and  GPS (or  RS232)  for  a  precise  timing 
synchronization. The LAN port can also be referred as the Ethernet port.

Figure 3. Side view of the MR3000 showing three plug-in connectors for power, LAN and GPS.

2.2.1 Power

The MR3000 provides several power supply options, that is, external 12 VDC (Battery or AC/DC), 
Power over Ethernet (PoE) according to IEEE 802.3af, or a combination of them. The following 
figures illustrate these options. 

2.2.2 LAN

The  MR3000  interfaces  to  a  standard  10/100-BASE  LAN.  Its  IP  address  is  indicated  in  the 
character display on the top. 

The MR3000 also supports the IEEE-1588 Precision Time Protocol (PTP) which allows for precise 
timing synchronization among multiple MR3000 instruments over the network. 

2.2.3 GPS/RS-232

The MR3000 provides an external  standard RS-232 port,  which can be used to connect to an 
appropriate GPS module or any other RS-232 attachment. 

2.3 Wireless communication

2.3.1 Wi-Fi/Bluetooth

The MR3000 incorporates a WiFi/Bluetooth module for wireless communication.  An appropriate 
antenna is provided.
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2.3.2 GPRS/SMS

The MR3000 is also equipped with a GPRS modem. It can be used for the MR to send SMS, or to  
establish a data link between the MR and the outside world.

In order to enable this feature, one must insert a SIM card in the MR.

Figure 4. Inserting a SIM card in the MR.

The procedure is quite simple:

1. Ensure the MR is turned off.

2. Unscrew and open the lid.

3. Pull out the SIM card tray by pushing the button at the left.

4. Insert a SIM card in the tray, and put the tray back in its place.

2.4 Misc

2.4.1 Time

The MR is equipped with a real-time clock with back-up battery. Even if the MR is switched off, the  
clock continues working.
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2.4.2 Sensor related parameters

For the MS3004+ Triaxial Accelerometer, the most important parameters are:

Principle Micro mechanical (MEMS), force balance accelerometer (FBA)
Direction 3 orthogonal directions (tri-axial)
Measuring range 0.069 mg to 2 g
Frequency range 0 to 150 Hz

14111000_MR3000-int-MS_v_0.4.odt • printed: 07/05/12  subject to technical change without notice



 - 10 - SYSCOM

3. INSTALLATION AND SET-UP

3.1 WARNING - Static Electricity

The MR3000 contains CMOS devices and when serviced, care must be taken to prevent damage 
due to static electricity. 

Disconnect DC supply power and turn-off the MR before opening the MR housing.

3.2 Batteries

External lead-acid gel cell 9 Ah with integrated battery charger: AC 90-264 V / 47-63 Hz.

3.3 Mounting of the MR3000 Recorder 

What you need for installation:

• 1 MR3000 Recorder Unit

• 1 DC Power Cable or a power cube with cable (AC/DC Converter)

• 1 LAN communication cable

• PC with Internet and a web browser inside

• MR3000 Quick Start Guide 

• Set of tools (Allen-keys)

Proceed as follows:

• Find a suitable place for the recorder. It must be floor or wall mounted (according to its type), 
at the desired sensor position. 

• Install the recorder with 4 M8 Allen screws.

• Connect the MR3000  to the ground.

3.4 First Start

• Connect a power supply  (12 VDC or PoE) to the MR3000.

• The green POWER LED indicator turns on.

• Connect to the MR using procedure described in chapter 4.
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3.5 Installation Options

3.5.1 Power Supply

The MR3000 provides several power supply options, that is, external 12 VDC (Battery or AC/DC), 
Power over Ethernet (PoE) according to IEEE 802.3af, or a combination of them. The following 
figures illustrate these options. 

3.5.1.1 External 12 VDC Battery

Any  12  VDC  battery  may  be  chosen  as  long  as  it  meets  the  capacity  requirements  of  the 
application. In Figure 5 a Syscom battery is presented.  

Figure 5. This picture shows the set-up of a MR3000 connected to an external 12 VDC battery..

3.5.1.2 External AC/DC Power Supply

Alternatively, the MR3000 may be powered by a 12 VDC AC/DC supply. An example of set-up is 
showed in Figure 6.
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Figure 6. This picture shows the set-up of a MR3000 connected to an external AC/DC battery.

3.5.1.3 Power over Ethernet

The MR3000 provides the option to be used as a Powered Device (PD) using Power over Ethernet  
(PoE) according to IEEE 802.3af standard. An appropriate commercial/industrial PoE switch along 
with a 48 VDC supply allows for to use the LAN connector as a combined communication/power 
plug.  The PoE switch injects  the 48 VDC into the data lines which are then extracted  by the  
MR3000. According to the selected PoE switch, multiple instruments may be linked to a combined 
communication/power network. An example of PoE arrangement is presented in Figure 7.

Optionally  a  battery  or  UPS  may  be  hooked  to  the  PoE  switch  to  accommodate  for  power 
interruptions.
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Figure 7. The setup in this picture we can see a MR3000 and a laptop being powered from a PoE splitter, via LAN 
connectors.

3.5.1.4 Combined Power Options

The MR3000 may also be powered by a combination of PoE and an auxiliary external 12 VDC 
supply (battery or AC/DC). The MR3000 automatically manages the power sources and switches 
off PoE as soon as external 12 VDC are detected.
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4. OPERATING THE MR3000

4.1 Connecting to the MR3000

After being turned on, the MR takes around 1 minute to start and be ready.

There are several  ways to connect  to  the MR. Depending  on the method you choose,  the IP 
address of the MR will be different. The following paragraphs describe these methods, and the IP 
address that goes with it. You will need this IP address to connect to the Web User Interface.

4.1.1 Wired connection

Connect using the cable RJ45/LEMO  provided with the MR. On the MR side, plug the LEMO 
connector into the “LAN” port. On the other side, you can connect:

• directly on your computer

• on  the  local  area  network  (LAN)  of  your  company,  where  your  computer  is  already 
connected.

Figure 8. RJ45 connector on top, LEMO connector below.

If you connect the MR directly to your computer, you must then configure the IP address of your 
computer. The default IP address of the MR is 192.168.1.1, and is displayed on the LCD. Therefore 
you must assign a static IP address to your computer, on the same sub-network as the MR. For 
example, 192.168.1.2.

If you connect the MR to a network, it may or may not receive an IP address. It depends on the 
security policy of your company. When you plug the cable, have a look at the LCD. You should see 
the  message  “Sending  DHCP  requests...”  displayed.  After  that  message,  if  the  IP  address 
displayed  is  the  default  address,  ie  192.168.1.1,  it  means that  the  MR failed  to  obtain  an  IP 
address. You should disconnect the MR and contact your network administrator.
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But if the address displayed is something else, the MR did obtain an IP, and you have nothing to 
configure on your computer.

Now, you can simply enter the IP address displayed on the LCD in your web browser.

4.1.2 Wireless connection

You can easily connect to the MR through the Wi-Fi interface, as you would do with any other Wi-
Fi.  The default  name broadcasted  by  the MR is  “mr3000”,  followed by  a dash and the  serial 
number.

After the connection is established, the MR IP address is 192.168.30.1. It's this IP that you must 
enter in your web browser.

4.2 The Web User Interface

After the connection with the MR is established, and the IP address of the MR is known, opening 
the Web User Interface (WebUI) is quite easy. Just launch your favorite web browser, and enter the 
IP address of the MR in the address bar. Depending on your web browser, you may have to enter 
the letters “http://” before the IP address.

The interface is divided in 3 main tabs:

• “Home” displays some status information.

• “System” allows you to configure the interfaces, and some services related to it.

• “Parameters” contains all the recorder settings.

After you modified some settings on a page, you can:

• click “Apply” to validate your changes. It means that the content of the page is sent to the 
MR, which will restart all services accordingly.

• Click “Restore” if you want to discard your changes.

NOTE: If you don't click “Apply” and leave the tab, your changes are lost.

4.2.1 Home

This page displays some information about the MR. This page is not dynamic; if you want to update 
the information displayed, you need to do it manually by clicking on the button “Refresh”.

• ID contains  the  name of  the  MR,  followed by a dash and its  serial  number,  and the 
firmware version.
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• Ethernet displays the IP address of the MR on the Ethernet port, and the MAC address of  
the interface.

• Wi-Fi shows the Wi-Fi status, the SSID (or access-point name), the IP and MAC address 
of the interface.

• Clock displays the current time and date on the MR. Don't forget to click on refresh if you 
want to see the time go on.

• VPN gives the status an IP address of the Virtual Private Network.

• SD-Card tells about the total  size, and the free size on the SD-Card. It  also tells the 
number of events on the MR.

• Sensor tells you for which sensor the MR is configured.

• Activity reports the current activity of some service: trigger tells if the MR is recording an 
event, background if the MR is recording background, and alarm if the MR alarm levels 
are reached.

4.2.2 System

In this part, you find all the settings concerning the different interfaces of the MR, and different 
services.

4.2.2.1 General

Here, you can only change the name of the MR. This name is useful if you have more than one 
MR. It is used in the messages you may receive from the MR, in the events recorded, as a default  
Wi-Fi SSID, and in various other places.

If you have several MR, you should give a different name to each one to avoid confusion.

4.2.2.2 Time

In the  timezone part, you can choose whether you prefer the MR to work in UTC time, or local 
time.

NOTE: If you change this parameter, be sure to “Apply” your changes BEFORE setting the time. 

In the  time synchronization part, you decide if you want the MR to stay synchronized with an 
external source.

• Disabled means  that  you  don't  want  synchronization.  The  MR  is  on  is  own  for 
timekeeping. He's able to do that, it keeps the time even when it's powered off. However, 
electronics  component  involved  in  timekeeping  always  have  a  drift,  depending  on 
unpredictable factors like temperature. As a consequence, the MR will slowly drift away 
from the right time.
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If  you  don't  want  synchronization,  you  can  set  the  time  by  yourself.  You  can  do  it 
manually, which is not very handy and accurate, but works in every situation.

However, if the MR has Internet access, you can set the time by using the NTP protocol. It 
takes around 10 seconds, depending on the speed of your Internet connection, and it's far 
more accurate than setting the time manually.

• By  choosing  NTP,  you  mean  that  the  MR  has  an  Internet  access,  and  will  stay 
synchronized using the Internet. You can specify between 1 and 4 NTP servers. The more 
servers are used, the better precision you'll  get. So it's usually good practice to use 4 
servers.

The accuracy of the synchronization depends on the quality of the Internet connection, 
and also of the servers you choose. The closer you are to the servers, the better precision 
you get. The typical accuracy on the Internet ranges from about 5ms to 100ms, possibly 
varying with network delays.

The 4  default  servers  (0.pool.ntp.org,  1.pool.ntp.org and so  on)  are  in  fact  4  servers 
randomly picked up around the world. It always works, but if you want a better accuracy, 
you should put in these fields servers from your country. For example, if the MR is in 
Switzerland, you should set the 4 servers to  0.ch.pool.ntp.org,  1.ch.pool.ntp.org and so 
on. It will pick up 4 servers randomly in Switzerland.

You can find more information about the NTP servers available in your country on the 
website pool.ntp.org.

• If you ordered a  GPS with your MR, you need to select that. Then the MR will keep its 
time synchronized with the GPS time, the accuracy being around 1ms.

4.2.2.3 Ethernet

In this tab are the settings for the ethernet port (labeled LAN on the MR).

Modes are as follow:

• DHCP means that the MR will try to get an IP address by sending DHCP requests. You 
must  select  this  options  if  you  plug  the  MR on  a  network  with  a  DHCP server.  For  
example, your company network, or any network with a router.

If this network provides Internet access, the MR will be connected to Internet. You can 
check that with the ping button (see the Upgrade section below). Having Internet access 
is useful for some services, like NTP time synchronization. 

If the MR fails to receive an DHCP reply, it falls back to the default IP address provided 
below.

NOTE: if the MR doesn't get an IP address when you plug it on your company network, 
this is probably because of the security policy of the network. You should contact your 
administrator.

• Static means that the MR will use the static IP address provided below. You should select 
this option if you plug the MR directly to your computer, and then configure your computer 
accordingly.
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Static IP is the IP address used in static mode,  or as a fallback address in DHCP mode.  This 
address is a private address, and therefore must be in one of the following ranges:

• 192.168.0.0 and 192.168.255.255

• 172.16.0.0 and 172.31.255.255

• 10.0.0.0 and 10.255.255.255

4.2.2.4 Wi-Fi

You can enable or disable the Wi-Fi with the enabled checkbox.

When enabled, the MR behaves as a Wi-Fi access point. That's to say it broadcasts a network 
name, and you can connect to it with your laptop. The MR uses a static IP address (192.168.30.1), 
and will give a dynamic IP to your laptop when the connection is established.

You can configure the SSID (Service Set Identifier, it's the name broadcasted by the MR). If none is 
provided, the default SSID is “mr3000-12345678” (where 12345678 is in fact the serial number of 
the MR).

You can also configure the channel, between 1 and 11. You should use this in a place where there 
are already a lot of Wi-Fi access points available. You can look at which channels are used by the 
different access points, and choose the less used to have better performance.

The encryption is set to open by default, it means that no password is needed, and everybody can 
connect to the MR. It makes it easier for you to connect the first time, however it's not secure at all.  
So, if you plan to let the Wi-Fi enabled, you should change this and set the encryption to WPA or 
WPA2.

The WPA2 is the last version of the protocol and therefore should be used. Use the WPA mode 
only if your computer doesn't support the WPA2.

4.2.2.5 Mobile

Use the “enabled” checkbox to enable or disable the mobile communication service. Be sure to 
insert  a SIM card in the MR before trying to get the mobile  communication to work. After  you 
checked this field, don't forget to click on the “Apply” button. The mobile chipset takes some time to  
start, between 30 seconds and 1 minute.

If the SIM card is protected by a PIN code, you must enter it in the field. Otherwise, just let it blank.

Now, you must understand that a SIM card will offer you two kind of services, that are completely 
different  and independent.  The SMS (or Short  Message Service),  that  is well  known.  And the 
GPRS, which allows you to send data over the telecommunication network. You don't  have to 
enable both of these services if you don't need to. Once you enabled the mobile service, it enables 
automatically the SMS service. And furthermore, if you need to, you can enable the GPRS service.

For the SMS, you may need to enter a center number. It depends on your SIM card, some already 
have a center number stored on it, some don't. So you can try at first to send a test SMS, and if it  
doesn't work, you probably have to enter a center number. This number is provided with your SIM 
card documentation.
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If you wish to enable the GPRS, click on the enabled box. You also have to enter an access point 
name, which is provided with your SIM card documentation. As a consequence, the MR will have 
an access to Internet through the GPRS interface.

NOTE: For the moment, the MR can't access the Internet through two different interfaces at the 
same time. So, if you connect the MR to a network with a LAN cable, it's very likely that  
the MR will have Internet access through this network (you can verify that with the ping 
button, see the Upgrade section below). If you keep it connected to the network, and try 
to enable the GPRS, the MR will have two ways to go Internet: the LAN cable and the 
GPRS.
The MR doesn't  handle this  situation  properly,  so you shouldn't  do that.  Be sure to 
unplug the LAN cable before enabling the GPRS.

4.2.2.6 Contacts

In  this  section  you add  contacts.  Contacts  are  people  who  receive  notification  from the  MR, 
depending on events happening. You can add a new contact by clicking the Add button. Then, if 
you want to edit or remove a contact, just check the box in front of it, and click the Edit or Remove 
button.

After you changed anything on the contact list, don't forget to click on the Apply button.

A contact is made of a name, a phone number to receive SMS, a mail address to receive e-mails 
(this is currently unavailable, but shoud be implemented soon in a further release). Then, you can 
select which type of events will lead to the delivery of a message to this contact.

4.2.2.7 VPN

VPN stands for Virtual Private Network. With this service, you will be able to communicate with the 
MR event if it's in a remote location, as long as it has Internet access.

The  configuration  is  fairly  easy,  you  just  have  to  click  the  enabled box,  then  upload  the  4 
configuration files on the MR, and click on Apply.

The configuration files (sometimes referred as VPN key) are provided by SYSCOM.

4.2.2.8 FTP synchro

If this service is enabled, the MR will automatically connects to a remote FTP server and copy its 
data to it. Actually it's more than just a copy: the MR will keep the FTP server synchronized with its  
data. At each connection, the MR will compare its own data to the FTP data, and any missing file 
on the FTP will be copied.

This feature requires the MR to have an Internet access.

This feature has two main purpose:

• it's a permanent backup, your data exist both on the MR and the server.

• It's also a way to make the MR's data available easily. If you can't reach the MR on its 
remote site, you can however access the data on the server. Additionally, you probably 
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have a high-speed connection with the server. So it's more convenient to retrieve some 
data from the FTP server than from the MR itself.

The parameters are easy to fill:

• FTP server is the URL address of your FTP server (without the ftp:// prefix).

• Username is your login for this server

• Password is used to authenticate the user on this server.

4.2.2.9 Upgrade

In this section, you find two things:

• The ping button allows you to send a ping request to a website. It's useful if you want to 
know whether  the MR is connected to Internet.  If  you can ping a well-known website 
(wikipedia.com for example), if it succeeds, the MR is connected to Internet. If it doesn't, it 
means that MR can't reach Internet.

• The upgrade part is used to do a remote upgrade of the MR's firmware. MR needs an 
Internet connection for that.

In order to upgrade to a new firmware, you need to know the URL for this upgrade. This is 
provided by SYSCOM when a new firmware is available.

Once you entered this URL in the field, click on the start button. Upgrade takes usually 
between 1 and 2 minutes, but it  can be longer if  the Internet connection is slow. You 
should just be patient, and never turn off the MR while an upgrade is in progress.

If an error happens, a message will be displayed on the LCD screen of the MR.

4.2.2.10 Misc

For the moment, this section contains the manual recording buttons.

You can start recording an event by clicking on the start button, and stop the recording with stop. 
When the MR is recording, the orange LED turns on on the MR. If you want to see whether the MR 
is recording from the webUI, you can click on the  Home tab, then click the  Refresh button. The 
Activity/Trigger part tells you that.

4.2.3 Parameters

In this part are all the settings of the MR as a motion recorder.

When we speak  about  “signal”  in  this  chapter,  it  actually  means  “the  signal  coming  from the 
sensor”.
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4.2.3.1 Acquisition

The acquisition rate can vary from 50 Hertz to 1000 Hertz.

You can also apply a filter on the signal, among the filters proposed. Different kind of filters are 
available:

• No filter if you don't need one. There is however a cut-off applied at 80% of the Nyquist 
frequency.

• Infinite Impulse Response (IIR) filters.

• Finite Impulse Response (FIR) filters.

4.2.3.2 Trigger

The trigger is a feature that allows the MR to automatically record if the signal reaches a certain 
level. It's the main feature of such a recorder. When the signal is above the level, we say that the 
MR is “triggered”. When it comes back under the level, we say that the MR is “untriggered”.

You can disable it if you just want to do some manual recording. But if you plan to use the MR to 
watch over a site, you must let it enabled.

You can choose between two file formats:

• XMR is the format that was used in the MR2002 recorder. The main advantage is that it's 
been around for quite a long time, and different software exist to view these files. There is 
EAWLight, available for free on SYSCOM website, and VIEW2002.

• ASCII is a simple format,  where all  the data recorded is put in a simple text  file.  It's  
convenient if you plan to use a software like Octave or  Matlab to view and process your 
data.

Time section contains important settings:

• with  the  pre-event time,  you  decide  how long you want  to  record  before  the  MR is 
triggered. You can record up to 20 seconds backward.

• With the post-event, you tell how long you want to record after the MR is “untriggered”. If  
the MR is triggered again during this time, the post-event countdown will restart from the 
beginning.

• The maximum length setting allows you to choose the maximum length of an event file. If 
this limit is reached, the MR closes the file, and continues recording in another file.

Combination let you decide when you consider the MR is triggered. You may want to watch only 1 
axis, or more. If you watch more than one axis, you can decide if the MR is triggered when all the  
axes are above the level, or just one of them. You choose it with the AND/OR logic. A common 
setting is to watch the 3 axes, and trig when one of them is above the level.

The level section let you set the level for each axis.
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4.2.3.3 Background

The background is the second main feature of the MR. When the background is enabled, the MR 
records continuously. But it doesn't record all the data coming from the sensor, since it would take 
too much space. What is recorded depends on the mode you choose:

• VM Peak is the maximum absolute value of the unweighted signal (particle velocity signal) 
over the duration of the measurement period according to DIN 45669-1.

• KBFTi represents  the  maximum  cycle  averaged  weighted  vibration  severity  over  the 
measurement period according to DIN 45669-1.

You can also choose the period between two samples, and the length of a file.

4.2.3.4 Alarm

With the alarm feature enabled, the MR is able to send a SMS when a certain level is reached. The 
exact moment when the SMS is sent depends on the parameters in the time section:

• Holding time behaves pretty much like the post-event described above. It's the time that 
the MR will wait after the signal comes back below the level. If the signal reaches the level 
again, the holding time countdown will be restarted. And only when this countdown ends, 
the SMS is sent.

As you can see, it's impossible to know exactly how long it will take for the SMS to be 
sent, that's why there is a second parameter.

• If the first countdown is still running when the  maximum delay is reached, the alarm is 
stopped, and the SMS is sent.

You can also set the level for each axis, and for each alarm.

For  each  alarm,  you  can  choose  a  message that  will  be  sent  in  the  SMS.  This  is  optional. 
Additionally, you can check the box “Add infos”. This will append some useful information to the 
text you entered: the date and time when the alarm happened, and the peak value.

4.2.3.5 Daily news

This service gives you the possibility to receive a SMS once per day from the MR. You can choose 
the  time when you wish to receive this SMS, and an optional  message. Some information are 
automatically  appended:  the  number  of  events  and  the  free  size  on  the  SD-Card,  and  the 
background mode.

4.2.3.6 Datastream

If enabled, the MR can send a datastream to any client who connect to it. The stream is in the 
miniSEED format, you can find more information on this website:

http://www.iris.washington.edu/manuals/SEED_appG.htm

In order to receive this datastream, one need to connect to the MR on the port 5002.
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In order to do something with this stream, one need to implement a miniSEED client, which will be  
able to receive and decode all this data, and display it.

4.3 The real-time dispay

By connecting on the port 8080, it's possible to see the data from the sensor, and the background 
data. To connect on the port 8080, just append “:8080” to the IP address of the MR in your web 
browser address bar.

4.3.1 Real-time sample plot.

In this section, you can see the data coming from the sensor, and filtered (if any filter is selected, 
see section 4.2.3.1).

The X axis is the time, the Y axis is the value.

Each axis is can be unselected, so that you can display only one axis if you want.

The query refresh period is the period between two requests from your computer to the MR. If 
you set it to a small value (like 100ms), the display is smooth, but also requires more power from 
your computer. If you feel that your computer is slow because of that, you should try a bigger value 
like 1 second.

The  sample  grouping tells  how much samples represents  1 pixel.  If  you set it  to  1,  the line 
displayed represents exactly the signal, but also it goes at the same rate. Which mean very fast. If  
you want to have time to see what's happening, you must increase this value. As a result, the 
display is slower, and the line becomes an approximation of the signal. Behind the line, same color 
but lighter shade, is drawn the envelope of the signal.

The vertical zooming, or simply zoom, is exactly what its name suggest. A value of 1 means no 
zoom, a value of 100 means that signal is multiplied by 100.

4.3.2 Real-time background plot.

Here you can visualize the background data, as selected in the section 4.2.3.3.

The settings are the same as in the real-time sample plot, but additionally you can move the display 
with the arrows. You can see at least one day back in time, probably more. It depends on the 
period  you set  in  the  background  settings.  The  simple  arrows  allow  you  to  move  forward  or 
backward, and the double arrows send you back at the beginning or the end of the graph.

If you're positioned at the end of the graph, it will scroll by itself when a new sample arrives.
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4.4 Additional services

4.4.1 Embedded SFTP server.

The  MR  has  an  embedded  SFTP  server,  that  allows  you  to  easily  download  events  and 
background files from the MR to your computer.

First thing you may want to know, what does mean SFTP ? You probably know about FTP (File 
Transfer Protocol), the most common way to transfer files from a server to a client. Well, SFTP is 
basically the same, except that it's much more secure. With SFTP, all data going from the MR to 
your computer is encrypted using the SSH protocol.

Using  SFTP is  exactly  the  same as  using  FTP:  first,  you  must  install  a  SFTP  client on  you 
computer. Then you connect to the MR (which is the server), and you can browse the events and 
background files. The login and password you need to know are:

Login: user
Password: syscom

NOTE: Every SFTP client  has a refresh button  somewhere.  When you browse through the 
content of the MR, and you don't see the files that are supposed to be there, just click 
the refresh button.

Below you'll find a list of SFTP clients with a quick explanation on how to use it. All theses software 
are free, and widely available on the Internet.

4.4.1.1 Filezilla

It's the most famous FTP/SFTP client. You can download it at this address:

http://filezilla-project.org/download.php?type=client

The first time you launch it, click on File->Site Manager..., then click on New Site. In the host field, 
enter the IP address of the MR3K. For the protocol, choose SFTP. For the logon type, choose 
normal. Then, enter your login and password, and click Connect.

4.4.1.2 WinSCP

As an alternative to Filezilla, there is WinSCP. You can get it at this address:

http://winscp.net/eng/download.php

The first time you launch it, click on the New button. The settings are the same as described in the 
section 4.4.1.1.
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4.4.1.3 FireFTP

Another alternative for the Firefox users is to install the add-on FireFTP. Therefore you don't need 
to run another program, this FTP client is directly integrated into your web browser.

To install it, launch Firefox, and click on Tools->Add-ons. Then choose and install FireFTP, and 
restart Firefox. Then you need to add a button for a convenient access to FireFTP: just click on 
View->Toolbars->Customize, find the FireFTP button, and drag/drop it to the toolbar somewhere.

Click  on  this  button  now,  the  FireFTP tab  will  appear.  Select  “Create  an account”.  Enter  an 
account name (whatever you want to name this connection), and fill the host, login and password 
fields as mentioned in the section  4.4.1.1.  Then click  on the  connection tab,  and in the field 
security, select SFTP.
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Appendix A: Internet access for the MR

We often talk about the MR having an Internet access on this manual, so let's clarify this point a 
little bit.

First, why should the MR have an Internet access ? Well, there are various reasons:

• some services, like NTP time synchronization, or FTP synchronization, can't work without 
that.

• upgrading the firmware requires Internet access.

• if the MR is somewhere else than in your office (so basically, when you're not configuring  
but using it), you can't reach it unless MR has Internet access.

Now, how to have this Internet access ? If you read carefully the previous section, you noticed that 
there are two ways to achieve that:

• through the Ethernet interface, if it's configured in DHCP mode.

• through the GPRS.

You also remember that you can't use this two modes together (see the note in the section 4.2.2.5).

How to test if the MR can access to Internet ? There is a ping button in the webUI (see the section  
4.2.2.9). A ping is basically a request sent to a website, to check if it's available. It's a common way  
to see whether you can reach Internet: if you can ping a website, you're connected to Internet.

Now, what does really mean “having an Internet access” ? That's a little bit more complicated that it  
seems. When a device access the Internet, it's a little bit like if it was in a bubble: the LAN (or Local 
Area Network). From this bubble, he can reach the outside world (Internet), but this outside world 
can't reach it. The consequence is quite obvious: if you put a MR on a remote site, with an Internet 
connection, the MR can reach the outside world, and do what it has to do on the Internet (NTP/FTP 
synchronization for example). But YOU can't reach it. Well, at least, you can't unless you use some 
additional software.

We don't  want to enter in thorough explanations here about the WHY you can't reach it.  It's  a 
question of IP addresses, deep understanding of what is a LAN, and other technical details that are 
not interesting here.

What we want to say is that you need a little bit more than just an Internet connection on the MR. 
You also need a software that will allow you to communicate with the MR. The VPN is such a 
software, and the Dynamic DNS is another.

To sum up this chapter in a few words:

• for some services, you need the MR to have an Internet connection

• additionally, if you want to be able to reach the MR remotely, you need to use a service 
like VPN or Dynamic DNS.
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